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History 
The development of SIMFOR began in 1991 in the Center for Applied Conservation Biology, Faculty of Forestry, 
University of British Columbia.  SIMFOR was originally developed by Fred Bunnell, Dave Daust and Rob McCann, as a 
research tool to facilitate asking questions about amounts and distribution of old-growth habitat that arose from the 
provincial government’s Old Growth Strategy.  Approaches to addressing the questions were encouraged by Bill 
Bourgeois.  The original version was coded in Pascal for a DOS platform.  At the outset, SIMFOR did its own harvest 
scheduling, but this approach was quickly recognized to be a duplication of John Nelson’s (Faculty of Forestry, University 
of British Columbia) work with the ATLAS harvest scheduler.  Subsequent development has allowed SIMFOR to respond 
to any spatially explicit harvest-scheduler, though it has most often been linked to ATLAS. 
 
Over the next 4 years (1991-1994), Dave Daust redeveloped SIMFOR in QuickBasic, still utilizing a DOS platform.  The 
original focus of the tool – to help design spatially-explicit research – was never wholly attained.  However, SIMFOR was 
quickly able to expose unforeseen consequences of rule-based approaches to sustaining habitat.  In response to requests 
from government agencies and industry, SIMFOR became increasingly used as a planning tool. 
 
The arrival of the Forest Practices Code in British Columbia (1995) necessitated the use of spatially-explicit planning 
tools that allowed projections of impacts of forest policy and practices.  In response, the redevelopment of SIMFOR in a 
Windows environment, with a more formal linkage to the ATLAS harvest scheduler, was initiated.  The software was 
linked to a Microsoft Access database, and core algorithms were divided into 2 modules – Habitat and Landscape.  Mark 
Hafer coded modules in C++.  Glenn Sutherland, Dave Gizowski and Ralph Wells developed and coded the linkage with 
Access and a Windows interface for SIMFOR in VisualBasic.  In 1998-1999, Ralph Wells worked with programmer Dave 
Cowperthwaite to develop a new viewer and interface, allowing the output of ASCII files from Access for use in SIMFOR 
modules.  In 2000-2001, Wells and programmer Arnold Moy designed SIMFOR Version 3, linking SIMFOR to the ESRI 
Arcview 3 viewer and binary grid data format.  A new interface, linked to a re-designed Access database, was coded in 
Visual Basic and core algorithms were coded in C. 
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Overview 
SIMFOR Version 3.0 is a decision support tool designed to help managers and researchers evaluate the impacts of forest 
harvesting scenarios against landscape and habitat indicators.  SIMFOR can be used to evaluate the response of forest 
vegetation to harvesting treatments or natural disturbance events, and to calculate projected landscape and wildlife habitat 
conditions. 
 
The conceptual framework of SIMFOR habitat analysis is shown in Figure 1.  A harvest scheduler, such as ATLAS, 
produces a list of stand units that are treated according to a specific harvesting scenario.  SIMFOR combines this list of 
treatments with an aging routine to determine the future ages of stands (seral stages) and their expected structural values.  
SIMFOR can also incorporate natural disturbance events that are generated by a scheduler.  Stand structure is represented 
by the abundance of selected habitat attributes or variables.  By matching wildlife species requirements with these habitat 
attributes, SIMFOR estimates species-specific habitat suitability.  In addition, the software uses spatial relationships to 
project simple landscape metrics: seral stage, patch size and edge characteristics.  SIMFOR also allows projection of stand 
succession resulting from stand aging or harvest treatment.  Finally, SIMFOR is designed to maximize model 
transparency. so that model components (e.g. input variables such as habitat attribute curves) can be readily observed. 
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Figure 1:  SIMFOR flowchart showing general classes of model inputs and outputs. 
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New Features in Version 3.0 
 

• full featured expression builder  
• habitat attribute input maps (static and dynamic)  
• allows stand succession  
• direct link to ArcView 3.x with Spatial Analyst  
• stratified reporting on output maps  
• many refinements  

 
 
Introduction 
SIMFOR uses a raster-based spatial data format (ESRI ArcInfo binary grid data format) to spatially and temporally 
project simple landscape parameters and wildlife habitat conditions in response to harvesting and other disturbance 
events.  Harvest schedule and disturbance events are provided by an ASCII input file.  A user interface with full data entry 
and editing capability links to the model database (Microsoft Access 97 or greater).  The map viewer is Arcview 3.x with 
a “view stepping” tool designed to facilitate viewing model output.  The core software module of SIMFOR is coded in 
pure C to provide maximum speed for model runs. 
 
SIMFOR operates under Windows 9x, NT, 2000 and XP, and can run on fairly low-end machines effectively (e.g. 75Mhz 
PC with 32Mb of RAM), though performance will be affected accordingly.  There are no design limitations on the size of 
area or number of habitat attributes that can be handled by SIMFOR during a run.  We have undertaken habitat runs of 
moderate to high complexity on areas of more than 1 million hectares (1 hectare cell resolution); these runs took less than 
5 minutes on a 600Mhz PC with 256Mb of RAM. 
 
This user manual is primarily intended as a guide to the SIMFOR software.  An overview of SIMFOR’s basic 
functionality and design can be found on the SIMFOR web page at www.forestry.ubc.ca/simfor.  Perspective users should 
take time to review the web content.  An example project and citations of publications of SIMFOR projects can also be 
found on the website. 
 
SIMFOR installs with a sample database and two example analyses (one landscape and one habitat analysis).  These 
analyses are included at the end of the manual to assist users in learning the software.  Hot links to appropriate sections of 
the manual are included in the example analyses and throughout the manual (text in blue font). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 4

http://www.forestry.ubc.ca/simfor


Installation 
SIMFOR uses the ESRI GRID IO library to read and write ESRI GRID coverages.  ArcView 3.x or greater must be installed to enable 
this functionality.   
 
To install SIMFOR complete the following instructions. 
 
1) Locate the executable SIMFORXXXXX.exe (where XXXXX is the version number). 
2) Double-click on the file to start the installer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3) Select the installation directory and then press [Next]. 
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4) Press [Install] and wait for the installer to finish. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5) After the install has completed, you will be asked to reboot the computer. 
6) SIMFOR uses ActiveX Data Objects (ADO), which requires the MS Data Access Components to be installed.  Some operating 

systems like Windows 2000 will already include the Data Access Components.  If you see the following dialog box while trying 
to open a database, you will need to install the components.   

 
 
 
 
 
 
 
 

The latest RTM release of the MS Data Access Components can be found in the Downloads section of the Microsoft Universal 
Data Access home page at http://www.microsoft.com/data/. 
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Interface 
 
  

a

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The interface is a multi-document interface or MDI.  The main MDI form
opened forms are contained within the main MDI form with the exception
 
Menu 
 File 
  New – creates a new blank database 
  Open – open existing database 
  Save As – save the current database as another database
  Close – close current database 
  Exit – exit program 
 Edit 
  Setup – settings for map directories, ArcView, Data Vie
 Tools 
  Data Viewer – opens the Data Viewer 
  View Stepper – opens the View Stepper 
  Curve Calculator – opens the Curve Calculator 
  Map Diagnostics – opens the Map Diagnostics tool 
 Window 
  Arrange – not implemented yet 
 Help 
  About – splash screen for credits and other information 
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Status message area
Menus
 Toolbar
 has a menu, toolbar, status message area, and tray area.  All 
 of the View Stepper. 

 

wer and programs 



Toolbar 
 Species – opens the Species form 

Attributes – opens the Attributes form 
 Landscape – opens the Landscape form 

Curve Editor – opens the Curve Editor form 
 Legend Editor – opens the Legend Editor form 

Run Parameters – opens the Run Parameters form 
Data Viewer – opens the Data Viewer 
Setup – opens the Setup form 

 
Status message area 
 - application messages will appear 
 
Tray area 

- forms that are minimized will appear as icons in this section 
 
 
 
Using the Grid Control 
 
Here is a list of terminology used to describe the different parts of a Grid control. 
 
 
 
 

Grid Header

Grid AddNew Row Selector

Grid Row Selector 
Grid AddNew Row 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Grid Header – the header usually contains the name of the data column 
Grid Row Selector – selects the row when clicked on 
Grid AddNew Row – the row in which new data is added 
Grid AddNew Row Selector – selects the AddNew Row when clicked on 
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Most forms that contain a grid control share a common methodology for performing editing operations.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Editing functions are available in the context menu by right-clicking the mouse on the grid control row selector.  By holding down the 
shift key while clicking on a row, records can be selected and the appropriate context menu function can be applied.  Pasting new 
records can done in one of two ways: (1) right-clicking the mouse on the AddNew row selector (row selector with         icon) and 
selecting the paste function on the context menu, or (2) left-clicking the mouse on the AddNew row selector and using the shortcut 
key combination (ctrl-v).  When the AddNew row is selected, the icon will change from        to       .  The source data for pasting must 
be tab delimited between each field value. 

 
 
Where there is no AddNew row selector, the editing functions operate the same way with the exception of where the pasting begins.   
The above example shows what happens when two new records are pasted in the Attribute Definition section on the Attributes form. 
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Base maps 
SIMFOR requires five maps to establish the initial state of the landscape; these base maps must be present before any runs can be 
performed.  The five base maps are AGE, DISTURBANCE, STAND, BLOCK, and CALC. All maps must be ARC/INFO binary 
GRIDs and must share the same spatial extent and data area (see Map Diagnostics Tool).  Also, the maps must be located in the same 
directory to be properly referenced by the program.  See the Setup section and Run Options section for more information on setting up 
the base maps. 
 
AGE 
This map is used to set the initial age of each raster cell in the landscape.  The cell age value is used to (1) determine the supply of a 
curve-based attribute, (2) determine when a disturbance event occurs in the schedule file, and (3) determine the appropriate seral stage.  
Age values change for each run period and/or can be modified by a disturbance event in the schedule file.  
 
 
 
 
 

 
 
 
 
 

Figure 2:  Example of an age map. 

 
 
DISTURBANCE 
This map is used to set the disturbance type for each raster cell in the landscape at the time of run initiation.  Subsequent disturbances 
are introduced by the schedule.out file (see Schedule File).  The disturbance type cell value is used in conjunction with the stand type 
cell value to determine the appropriate supply curve required to calculate the supply of an attribute.  Disturbance type values will 
change when another disturbance type is applied to the same cell during the simulation. 

Figure 3:  Example of a DISTURBANCE map. 
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STAND 
This map is used to set the most recent stand type for each cell in the landscape.  The stand type cell value is used in conjunction with 
the disturbance type cell value to determine the supply curve required to calculate the supply of an attribute.  Stand type values can 
change through scheduled succession or natural succession.  Scheduled succession occurs at the time of a scheduled disturbance event 
in the schedule file.  Natural succession occurs when a defined age threshold is exceeded. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4:  Example of a STAND map. 

 
 
BLOCK 
This map is used to set the block ID for each cell in the landscape.  A block is the area to which a disturbance type is applied, as 
determined by the schedule file (see Schedule File).  The block map is static and does not change values throughout the simulation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5:  Example of a BLOCK map. 
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CALC 
This map is used to establish whether or not a calculation is to be performed on a particular cell.  Using binary values, the map defines 
the portions of the landscape that are to be analyzed.  A calc cell value of 1 means a calculation will occur.  A cell value of 0 means a 
calculation will not occur.  The calc map is static and does not change values throughout the simulation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6:  Example of a CALC map. 
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Species 
 
 

Legend 
Combo-Box 

Species 
List 

Species Definition 
List 

Habitat Suitability 
Expression Textbox 

Expression 
Builder 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Species form is used to define the vertebrate species to be modeled.  Each species must have a species definition and a habitat 
suitability expression.  To add a new species, enter a unique ID, name and description in the Species List.  Next, select attributes and 
response curves to create a species definition for the model.  Attributes and response curves are selected either by (1) using the drop-
down, or (2) directly entering the ID value in the appropriate Species Definition List column.  For more information on attributes and 
response curves, see the Attributes and section. After creating the species definition, build a habitat suitability expression either by (1) 
using the Expression builder, or (2) directly entering and editing the equation within the Habitat Suitability Expression Textbox.  A 
legend can be assigned to each species by selecting a legend from the Legend Combo-box.  For more information on legends, see the 
Legend Editor section. 
 
 
 
 
 
 
 
 
The IDs of the Attribute or Response curve can be toggled on or off by right-clicking on the Species Definition data grid header and 
selecting the appropriate option to toggle. 
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When a request is made to produce habitat suitability maps for a species, the values in the output habitat suitability map will be 
dependent on the species habitat suitability expression.  To produce a legend for species habitat maps, first set the map label and then 
set the lower and upper map legend bounds for each suitability class.  Then associate the legend for the species as explained in the 
above paragraph.  See the Legend Editor section for more information on legends.  Also, see Habitat in the Run Parameters section for 
more information on how to create output habitat suitability maps. 
 
An area summary table can be created for habitat suitability maps by using the area reporting script “S4_area stats” in ArcView.  
Ensure that the habitat suitability legend is setup correctly as the reporting script will use the legend to determine the total area for 
each suitability class.  See the avenue script “S4_area stats” in the ArcView Reporting Scripts section for more information. 
 
Expression builder 
 
 
 

Validate expression status Textbox

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Expression Builder form is used to create a mathematical expression that calculates habitat sui
of individual attributes and mathematical functions. The form has several key features - an Equation
and Functions Tree, a Validate Expression Status Textbox and the Builder Keypad.  The Attrib
into curve and map attributes. As the contents of the Attributes Tree are linked to the species defin
to be used in the expression are defined in the Species Definition List.  The Functions Tree node co
can be used to build an equation.   
 
To create an equation, select the appropriate attributes and functions by double clicking on the node
add operators and brackets. To check for errors in the equation, use the Validate button.  The valida
Validate Expression Status Textbox located just below the Builder Keypad.  The Validate Expre
the Reverse Polish Notation (RPN) form of the equation and will help debug any problems with the 
when resolving precedence and bracket issues.  Once the equation has been validated, click OK to r
equation will appear in the Habitat Suitability Expression textbox. 
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The following is a list of supported functions that can be used in an expression: 
 
Functions 

Arithmetic 
ABS() – computes the absolute value of its numeric argument 
CEIL() – computes an integer value equal to the greatest integer less than or equal to its numeric argument 
FLOOR() - computes an integer value equal to the greatest integer less than or equal to its numeric argument 
NEG() – reverses the sign of its numeric argument 
SQR() – computes the square of its numeric argument 
SQRT() – computes the square root of its numeric argument 

  
Boolean 

CRITICAL() – returns 0 for values of 0 and all other values return 1.  Mainly used in setting critical habitat 
elements. 

 Logarithms 
  EXP() - computes e to the power of its numeric argument 
  LOG() - computes the natural logarithm of its numeric argument 
  LOG10() – computes the common logarithm (base 10) of its numeric argument 
 Trigonometry 
  ACOS() - computes the arccosine of its numeric argument 
  ASIN() - computes the arcsine of its numeric argument 
  ATAN() - computes the arctangent of its numeric argument 
  COS() - computes the cosine of its numeric argument(in radians) 
  SIN() - computes the sine of its numeric argument(in radians) 
  TAN() - computes the tangent of its numeric argument(in radians) 
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Attributes 
 
Curve 
 

Attribute definition 
List 

Attribute
List 

 
The Attributes form is divided into 2 sections: curve- and map-based attributes. To add a new curve-based attribute, first enter a 
unique ID, name and description in the Curve Attribute List.  Second, create an attribute definition by assigning the appropriate 
supply curve to the different Ecosystem/Disturbance type combinations that occur in the Attribute Definition List.  The supply curve 
can be assigned either by (1) selection from the combo-box, or (2) direct entry of the correct supply curve ID into the Supply Curve 
column.  A legend can then be assigned to each attribute in the Curve Attribute List either by (1) selecting a legend from the combo-
box, or (2) entering the ID directly into the Legend column.  For more information on legends, see the Legend Editor section. 
 
When a request is made to produce output curve based attribute maps, the values in the output attribute map will be dependent on the 
Attribute definition.  To produce a legend for attribute maps, first set the map label and then set the lower and upper map legend 
bounds for each attribute class.  Then associate the legend for the attribute as explained in the above paragraph.  See the Legend Editor 
section for more information on legends.  Also, see Attribute in the Run Parameters section for more information on how to create 
output attribute maps 
 
An area summary table can be created for curve based attribute maps by using the area reporting script “S4_area stats” in ArcView.  
Ensure that the attribute legend is setup correctly as the reporting script will use the legend to determine the total area for each 
attribute class.  See the avenue script “S4_area stats” in the ArcView Reporting Scripts section for more information. 
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Map 
 
 
 
 File Name Prefix
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Map attribute
of static maps
of dynamic a
dynamic map
same director
Setup form.  
 
To add a new
using the app
box, or (2) en
 
 
 
 

 

Map Attribute 
List 
s are file-based and are referenced using a file name prefix.  Map attributes can be either static or dynamic.  In the case 
, the prefix is the same as the file name.  For example, the prefix for an elevation map named ‘elev’ is ‘elev’.  In the case 

ttribute maps, the prefix is the file name excluding the year designation.  For example, the prefix for the series of 
 attributes attrib001, attrib010, attrib050 is ‘attrib’.  For attribute maps to be properly referenced, they must reside in the 
y.  The correct directory for map attributes is the Attribute Maps Directory, found in the Map Directories tab on the 
See the Setup section for more information.  

 map-based attribute, enter a unique ID, name and description in the Map Attribute List.  Reference the correct file 
ropriate file name prefix.  An attribute legend can also be assigned either by (1) selecting the legend from the combo-
tering the ID directly in the Legend column. For more information on legends, see the Legend Editor section. 
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 Landscape 
 
 
 
The Landscape form contains stand, disturbance type, seral, patch and edge parameters.   These parameters must be defined prior to 
conducting any landscape-level or habitat analyses.    
 
Stand 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The differen
in the base s
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Stand succes
selecting it f
goto stand ar
name of an e
 
When a requ
succession e
maps, first se
The stand leg
the ID and N
legends.  Als
 

 

Stand Type 
List 
t stands to be included in the model are entered in this list.  The Stand ID must correspond to the values that are contained 
tand map.  

sion can be modeled by specifying a goto stand and a succession age.  The goto stand can be defined either by (1) 
rom the drop-down, or (2) entering it directly.  If stand succession is not desired, ensure that both the stand name and the 
e the same; alternatively, define a succession age greater than what can be modeled (e.g. 9999 years). When the ID or 
xisting stand is altered, the changes are simultaneously updated in all related forms that contain the stand. 

est is made to produce output stand maps, the values in the output stand map will be dependent on the occurrence of any 
vents, otherwise the stand map values will remain the same from one run year to the next.   To produce a legend for stand 
t the map label as STAND and then set the lower and upper map legend bounds using the Stand Type List ID values.  
end can also be generated automatically using the auto-fill function in the Legend Editor. The auto-fill feature will use 
ame values from the Stand Type List to produce the legend.  See the Legend Editor section for more information on 
o, see Landscape in the Run Parameters section for more information on how to create output stand maps. 
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Disturbance  
 

Disturbance 
Type List 

 
Disturbance includes the scheduled harvest events or natural disturbance events that are to occur on the landscape.  The different 
disturbance types to be included in the model are entered in the Disturbance Type List.  The ID of each disturbance must correspond 
to the values found in the disturbance type basemap and harvest schedule file.  When the ID or name of an existing disturbance type is 
altered, the changes are simultaneously updated in all related forms that contain the disturbance. 
 
When a request is made to produce output disturbance maps, the values in the output disturbance map will be dependent on the 
disturbance type set by the harvest schedule file (see Schedule File), otherwise the disturbance map values will remain the same from 
one run year to the next.   To produce a legend for disturbance maps, first set the map label as DISTURBANCE and then set the lower 
and upper map legend bounds using the Disturbance Type List ID values.  The disturbance legend can also be generated 
automatically using the auto-fill function in the Legend Editor. The auto-fill feature will use the ID and Name values from the 
Disturbance Type List to produce the legend.  See the Legend Editor section for more information on legends.  Also, see Landscape 
in the Run Parameters section for more information on how to create output disturbance maps. 
 

 19



Seral 
 
 

Seral Stage 
Definition List 

Seral Stage List 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Seral definitions are used for calculating different landscape statistics, including the distribution of seral stages, seral patches and seral 
edges.  User-defined seral stages are entered in the Seral Stage List.  In the Seral Definition List, an upper age limit can be set to 
define the seral stage of each stand type.   
 
When a request is made to produce output seral maps, the values in the output seral map will contain Seral stages that are identified by 
the Seral Stage List  Seral ID values.  To produce a legend for seral maps, first set the map label as SERAL and then set the lower 
and upper map legend bounds using the Seral Stage List ID values.  The seral legend can also be generated automatically using the 
auto-fill function in the Legend Editor.  The auto-fill feature will use the ID and Name values from the Seral Stage List to produce 
the legend.  See the Legend Editor section for more information on legends.  Also, see Landscape in the Run Parameters section for 
more information on how to create output seral maps.   
 
An area summary table can be created for seral maps by using the area reporting script “S4_area stats” in ArcView.  Ensure that the 
seral legend is setup correctly as the reporting script will use the legend to determine the total area for each seral class.  See the avenue 
script “S4_area stats” in the ArcView Reporting Scripts section for more information.
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Patch Definition 
List 
 defined as clusters of cells that share the same seral stage and are contiguously connected in eight directions.  This feature 
user to analyze the distribution of patch sizes across the landscape that results from a given schedule of harvesting activity.  
lasses are defined by the user in this table.  Users should note that values from this table are here for documentation 
nd are not directly used in the patch analysis algorithm.  Rather, this table is used to setup a patch legend using the legend 
 explained in the next section.  Patch sizes are defined by entering the upper limit values (in hectares) for each size class in 

efinition List.  Descriptions can either be numeric (e.g. 0-10ha) or text (e.g. very small). 

uest is made to produce output patch maps, the values in the output patch map represent the area of a patch in hectares.  To 
egend for patch maps, first set the map label as SERAL_PATCH and then set the lower and upper map legend bounds 
 the patch sizes.  The patch legend can also be generated automatically using the auto-fill function in the Legend Editor.  
ll feature will use the Upper Bound and Name values from the Patch Definition List to produce the legend.  See the 
itor section for more information on legends.  Also, see Landscape in the Run Parameters section for more information on 
te output patch maps. 

mary table can be created for patch maps by using the area reporting script “S4_area stats” in ArcView.  Ensure that the 
d is setup correctly as the reporting script will use the legend to determine the total area for each given patch size range.  
nue script “S4_area stats” in the ArcView Reporting Scripts section for more information.  Also, patches can be 
d by seral stages but seral maps must be used in this case.  See Seral in the Landscape section for more information on seral 
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Seral Edge 
Definition List
finitions are used to estimate the location and area of different edge/interior habitat types across a landscape.  An edge is 
ding to 3 parameters: “primary” age, “contrast” age and edge width.  The primary age determines the lower age bound of 
 cells) on the “interior” side of an edge.  The contrast age determines the upper age bound of cells (contrast cells) on the 
edge.  Thus, a given edge type occurs wherever a primary cell lies adjacent to a contrast cell.  The edge width is the 
edge effects extend into the patch, and is defined size units.  Edge types, age bounds and edge widths are entered in the 
efinition List.   

st is made to produce output edge maps, the 3 output edge map values are: 0=not edge, 1=edge, 2=interior.  To produce 
dge maps, first set the map label as SERAL_EDGE and then set the lower and upper map legend bounds identifying the 
lues:  0,1,2.  The edge legend can also be generated automatically using the auto-fill function in the Legend Editor.  See 
ditor section for more information on legends.  Also, see Landscape in the Run Parameters section for more information 
ate output edge maps. 

ary table can be created for edge maps by using the area reporting script “S4_area stats” in ArcView.  Ensure that the 
s setup correctly as the reporting script will use the legend to determine the total area for edge class.  See the avenue 
ea stats” in the ArcView Reporting Scripts section for more information.    
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Curve Editor 
 
 
 

Description
Textbox 

Curve 
Data List 

Curve 
List 

Curve 
Display

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Supply curves describe the change in quantity of a given attribute (habitat component) over time, with time on the x-axis and attribute 
abundance on the y-axis.  Response curves describe the response of a species to those changes in attribute supply, with attribute 
abundance on the x-axis and an index of habitat suitability on the y-axis.  See the Attributes section and the Species section for more 
information on supply and response curves. 
 
Supply and response curves are defined and edited within the Curve Editor. To add a new curve, select the appropriate curve tab 
(supply or response) then enter an ID in the Curve List, followed by a name and a description.  Enter the X and Y values for the 
corresponding curve in the Curve Data List. 
 
When the ID or name of an existing curve is altered, the changes are simultaneously updated in all related forms containing that curve.  
Changes to the ID or name of a supply curve will be reflected in the Attribute Definition List on the Attributes form.  Similarly, 
changes to the name or ID of a response curve will be reflected in the Species Definition List on the Species form. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Axis labels can be added/edited by using the context menu (right-click) or by double-clicking on the appropriate axis within the Curve 
Display area.  Curve colors can be changed by selecting the Curve Color option from the context menu (right-click) and picking a 
color from the Color Palette. 
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Legend Editor  
 

Map List 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Map legends, used wh
appropriate map tab (b
Map Legend List to e
on the RGB value and
are simultaneously upd
have read the section b
particular map” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Maps can be sorted, ei
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Map Legend 
List 
en displaying maps in ArcView, are created and edited within the Legend Editor.  To add a legend, select the 
ase, output or attribute) then enter an ID in the Map List, followed by a map label and a description.  Use the 
nter the lower/upper bound and text for each legend class.  To change the color of a legend class, double-click 
 choose a color from the Color Palette.  When the ID or name of an existing map legend is altered, the changes 
ated in all related forms that contain the legend.  To effectively use the legends with ArcView, ensure that you 
elow: “The data viewer uses the following criteria to determine how a map legend is assigned to a 

ther by ID or Map Label, by right-clicking on the Map Label header in the Map List and selecting the 
context menu item.  The ‘Auto Fill’ context menu item can be used to automatically fill in the map legend with 
.  Core maps have reserved Map Label names (AGE, BLOCK, CALC, DISTURBANCE, STAND, SERAL, 
AL_EDGE) and are highlighted in blue. These reserved Map Label names are required to link the appropriate 
nd.. 
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ArcView legend files can be imported, by right-clicking on the Map Legend header in the Map Legend List and selecting the 
‘Import Legend’ context menu item.  To display the legends in greyscale, use the ‘Display as greyscale’ context menu item. 
 
The data viewer uses the following criteria to determine how a map legend is assigned to a particular map: 
 
The map name is parsed and the following logic is used to link the map with the appropriate legend: 
 
• If the map prefix is “at” and the proceeding 3 characters constitute a numeric code, the number is used to search for the matching 

AttributeID in the Attribute table.  The MapInfo legend associated with the matching record is selected. 
 
• If the map prefix is “hs” and the proceeding 3 characters constitute a numeric code, the number is used to search for the matching 

SpeciesID in the Species table.  The MapInfo legend associated with the matching record is selected. 
 
• If the map prefix is “ss”, the MapInfo table is searched for the reserved MapLabel “SERAL”.  The SERAL legend is selected. 
 
• If the map prefix is “sp”, the MapInfo table is searched for the reserved MapLabel “SERAL_PATCH”.  The SERAL_PATCH 

legend is selected. 
 
• If the map prefix is “se”, the MapInfo table is searched for the reserved MapLabel “SERAL_EDGE”.  The SERAL_EDGE legend 

is selected. 
 
• If the map name is AGE, BLOCK, CALC, DISTURBANCE or STAND, the MapInfo table is searched for the matching 

reserved MapLabel name (AGE, BLOCK, CALC, DISTURBANCE, STAND), and the appropriate legend is selected.  
 
For all other maps, name matching is used to determine the appropriate legend.  The legend for whatever MapLabel (or portion 
thereof) that matches the map name will be selected. 
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Run Parameters 
 
 

Run Description 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Run Parameters form is used to set up habitat, attribute and landscape level analyses for a set of de
 
Habitat 
Select the ‘Habitat Suitability’ option from the Habitat Statistic Type column, then select the appropriate
column. 
 
Habitat Statistic Type 
 [8] Habitat Suitability 
 
Attribute 
To create a set of maps from a curve-based attribute, select the attribute from the Attribute drop-down or 
ID. 
 
Landscape 
Select a statistic from the Landscape Statistic Type column, then select the desired class from the Class c
 
Landscape Statistic Type 
 [1] Seral Stages 
 [2] Stand 
 [3] Disturbance 
 [4] Patch Sizes 
 [5] Edge/Interior 
 [6] Age 
 
Enter the years for which the analyses are to be evaluated in the Run Years List.  Period-based output m
of the file name.  These output maps include habitat suitability, attribute distribution, seral stages, stand, 
age. 
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Run Options 
 

Open Setup 
Form 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Before a run is
 
User-Defined 
The User-Defin
should be caref
 
Base maps 
The base maps
tab on the Setu
for more inform
 
Schedule File 
The schedule f
 
Year Polyg
5 3  
5      5  
10 755 
10 889 
 
The Year field
to the correspo
 

 

Base Maps 
Directory 
 

Open Base 
Map 

Choose Run 
Directory 

 executed, a user-defined no data value, base maps, schedule file and run directory must be

NoData 
ed NoData value is used to represent areas for which no data exists.  While the NoData va
ully chosen so that there is no possibility of overlap with actual map data values. 

 to be used in a run are given in this section.  The base maps directory was originally defin
p form; any changes to the location of the base maps directory must be made in the Setup
ation.  

ile used in SIMFOR is a tab delimited text file with the following format: 

on ID Disturbance Type  Reset Age Goto Stand 
 2   0  -1 
 2   0   1 
 5   0  -1 
 2   0  -1 

 indicates when scheduled events are to occur.  When a scheduled event takes place, the D
nding Polygon ID and the age of the polygon is reset to the age indicated in the Reset Age

27
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Window
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NoData 
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 chosen.   

lue can be any integer, it 

ed in the Map Directories 
 form.  See the Setup section 

isturbance Type is applied 
 field.   



The Goto Stand field is for optional use.  When a disturbance event occurs, the Goto Stand value changes the existing stand to the 
Goto stand that has been specified for the polygon (block).  The absence of this value or –1 indicates no change in the stand.  Goto 
Stand values are defined in the Stand map/table; see the Stand tab in the Landscape section for more information. 
 
Run Directory 
The results of each run are saved in a Run Directory.  Output map files are saved in this directory under a sub-directory called 
‘Outmaps’.  A log file, generated for each run, is saved in the root of this directory with the name log.txt.   
 
The run directory is specified by using the Choose Run Directory button to select the parent directory, after which a unique name for 
the given run is manually entered.  The run directory must have a parent directory, or the run will not be performed. If an existing run 
directory is selected with the Choose Run Directory button, it will be overwritten.  
 
Click the Start button to initiate a run.  The progress of the run is displayed in the Run Status Window and the contents are saved as 
the log file (log.txt) in the root of the Run Directory. 
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Data Viewer 

s 

 

Data Tree 

Map queue 

 
 
 
 
The Data Viewer is used to view output maps and other data from the currently loaded database. The Data View
Tree, a Map Queue and a View Options section.  The Data Tree contains 4 main root nodes: SIMFOR Datab
Base Maps and Runs.  The SIMFOR database file can be opened in MS Access by double-clicking on the SIMF
Clicking on the Attribute Maps and Base Maps nodes will list the various attribute and base maps.  When a run
output data files are added to the Data Tree in the Runs node. 
  

 
 
Right-clicking on either the Base Maps or Attribute Maps node will bring up the context menu as shown in the
choosing the ‘Explore’ context menu item, this will open Windows File Explorer to the directory.  By choosing 
Grid Explorer’ context menu item, this will open Grid Explorer to the directory.  For this option to work, ensure
installed and configured in Setup.  Choosing the ‘Properties’ context menu item will show the standard Window
dialog for the directory. 
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Right-clicking on the Run name node will bring up the context menu as shown in the above figure.  By choosing the ‘Attach Run’ 
context menu item, this will open the Browse for directory dialog, so that a run directory can be attached.  This feature is particularly 
useful for re-mapping a run directory when the directory has moved or renamed.  Caution should be taken when attaching runs, as the 
results may be incompatible with the current modeling parameters.    
  

 
Right-clicking on the Run node will bring up the context menu as shown in the above figure.  By choosing the ‘View Run Log’ 
context menu item, this will open the log file for the run, so that it can be viewed.  By choosing the ‘Detach Run’ context menu item, 
a run can be removed from the data tree.  To add the Run back, use ‘Attach Run’ as outlined in the previous above section.  By 
choosing the ‘Explore’ context menu item, this will open the Windows File Explorer to the run directory.  Choosing the ‘Properties’ 
context menu item will show the standard Windows file properties dialog for the run directory. 
  

 
Right-clicking on the outmaps node for a run will bring up the context menu as shown in the above figure.  By choosing the 
‘Explore’ context menu item, this will open Windows File Explorer to the directory.  By choosing the ‘Explore with Grid Explorer’ 
context menu item, this will open Grid Explorer to the directory.  For this option to work, ensure that Grid Explorer is installed and 
configured in Setup.  Choosing the ‘Properties’ context menu item will show the standard Windows file properties dialog for the 
directory. 
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There are several ways to place maps into the Map Queue.  Double-clicking on a map will place it into the Map Queue to the right.  
To add several maps at once, highlight the maps while holding down the shift key and then either (1) right-click and use the Add To 
Queue context menu item, or (2) drag the selected items into the Map Queue.  Once the map(s) have been transferred to the Map 
Queue, check the box to the left of the map name if you want to use SIMFOR legends in ArcView.  Click on the box to check 
individual maps, or click on the legend editor icon in the upper left corner of the Map Queue to check all maps simultaneously.  You 
can change this so that when queuing maps, the legend checkbox is turned on by default.  See the Data Viewer section in Setup to 
change the default legend behavior when queuing maps.  Also, see the Legend Editor section for more information on the criteria used 
for matching legends with maps. 
  

s 

 
 
 
 
 
 
There are 3 ways to control the display of maps in ArcView u
[Multi], (2) group related maps into separate views [Group],
option, the appropriate output view can either be selected from
refresh the list of Views) or typed in directly to create a new v
selected, press the ArcView button to load the maps into an A
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 or (3) display all

 the Views Com
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rcView view.   
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Setup 
 
The Setup form is used to define parameters for the map directories, ArcView, Data Viewer, external programs and other resources. 
 
Map Directories 
 

 
This section is used to define the location of the Base and Attribute maps.  Click on the appropriate button to select the correct map 
directory.  This section is also used to subsequently change the location of the Base and Attribute maps if necessary. 
 
ESRI 
 
 
 
 
 
 
 
 
 
 
 
 
 
This section displays the ESRI products that are currently installed on your computer. 
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ArcView 
 
 
 
 
 
 
 
 
 
 
 
 
 
This section is used to define viewing options for ArcView.  The View Aspect Ratio sets the view area and is calculated by dividing 
the view width by the view height.  The default View Aspect Ratio can be modified to maximize the view area for irregularly shaped 
landscapes.  The Table of Contents Ratio sets the area in which the themes are listed for each view and is calculated by dividing the 
TOC width by the view width.  The default TOC Ratio can also be modified to maximize the view area for irregularly shaped 
landscapes.  
 
If the Project window is not minimized when using the View Stepper, a flickering effect may occur while stepping through maps.  The 
flicker effect can be eliminated by choosing the Keep Project window minimized while stepping to reduce flicker option.  For 
more information on the View Stepper, see the View Stepper section.  To disable the ArcView 3.x Startup Wizard, choose the 
Prevent ArcView start up dialog from appearing option. 
 
Data Viewer 
 

 
 
This section is used to define options for the Data Viewer.  When maps are queued in the Data Viewer, the default SIMFOR legend 
can be set using the Default using legend when queuing maps option.  When going to view maps in ArcView, the Data Viewer will 
confirm whether or not to load ArcView if it is not already running.  This can be changed by using the Always confirm to start 
ArcView when not already running option.  For more information on the Data Viewer, see the Data Viewer section. 
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Programs 
 

 
This section is used to define what external programs are to be used with SIMFOR.  The Grid Explorer program aids with the 
management of grid coverages.  It can be used to move (copy/paste) files without corrupting the grid data structure.  To use Grid 
Explorer with SIMFOR, find where the Grid Explorer executable is located and select it.  
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Curve Calculator 
 
 

Y Textbox 

X Textbox 

Curve combo-box 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Curve Calculator can be accessed through the Tools menu.  It is used to interpolate values of Y for a given X value, and is 
particularly useful for hand-verifying model results.  To use the Curve Calculator, choose a curve type (supply or response) and select 
a curve either from the Curve combo-box or directly enter the curve ID.  Then enter a value for X in the X Textbox; the Y value will 
be returned simultaneously in the Y Textbox. 
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View Stepper 
 
 

Get Views 
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The View Stepper is used in conjunction with ArcView to display maps in one or more v
(1) scroll between run periods, (2) zoom simultaneously to the same area in all Views, (3
(4) customize the view order.  Maps must be already loaded in ArcView to use the View 
the Get Views button for a listing of available views and then select the desired views by
Box. 
 
To scroll between output maps for different run time periods, click on the up or down arro
Combo-Box indicates the time period for the currently displayed map. To zoom simultan
zoom on one view, highlight the view name in the view list, then press the Sync Zoom bu
use the R and C combo-boxes to specify the number of rows and columns for the display 
accordingly. The Aspect Ratio of each view can be adjusted by entering the ratio into the
each view can be adjusted by entering the ratio into the TR textbox.  To reorder views, dr
new position and then press the Tile view button to display the new order in ArcView.  
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Map Diagnostics Tool 
 

 

 
When creating maps for a particular area, the Map Diagnostics tool should be used to ensu
extent and data area.  If there are any mismatched maps, the results from a run may not be 
item from the Tools menu to start the diagnostics tool.  Now, choose a map that will be use
against.  Next, add the directories that contain the maps that are to be compared with the re
maps directory are included in the list by default.  These items can be excluded from the d
a directory for saving difference maps can be set with the Difference Directory selector, o
will be used. 
 
If there are any spatial extent problems, these will be flagged with a red X next to the prob
For each map that has mismatched data areas, a map is generated in the directory specified
These maps will identify where the input map is different from the reference map.  The dif
difference and 1=different.   Alternatively, a nibble mask can be created, so that it can be u
fill in the missing values.  To enable this option, ensure that the Create NIBBLE mask ch
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ArcView Reporting Scripts 
The ArcView 3.x project file report.apr contains Avenue scripts for creating a variety of area summary reports.  The following is a 
description of each script: 
 
 
S4_area stats  
This script will report area based on classes in the theme’s classified legend for seral stage, habitat suitability or seral edge maps.  To 
use this script, load the maps of one type into a new view and order them by run year.  Next, run the script on this view and a report 
will be created. 
 
Sample report: 
 
Year Name  Value  Area 
0 -1  1.00000000 234498.24 
0 -1 - 0.75  2.00000000 51700.68 
0 0.75 – 1  3.00000000 4082.40 
5 -1  1.00000000 234498.24 
5 -1 - 0.75  2.00000000 49656.24 
5 0.75 – 1  3.00000000 6126.84 
 
S4_patch stats 
This script will produce a report of area for a given patch size distribution.  To use this script, load seral stage maps into a new view 
and order them by run year.  Next, run the script on this view and you will be prompted to enter a patch size distribution.  Enter the 
patch size classes separated by a comma and make sure the last class is larger than the largest expected patch. Ie. 10,100,200, 999999. 
 
Sample report: 
 
Year Seral_Name Seral_Value S10  S100  S200  S999999 
0 -1  -1  3845.88  13970.88 2977.56  50032.08 
0 1  1  1072.44  7001.64  3570.48  11489.04 
0 2  2  3061.80  9674.64  2530.44  68866.20 
0 3  3  3249.72  9982.44  6787.80  72070.56 
0 4  4  1720.44  6645.24  3006.72  8725.32 
55 -1  -1  3845.88  13970.88 2977.56  50032.08 
55 1  1  8326.80  22291.20 4208.76  10014.84 
55 2  2  4072.68  12597.12 3797.28  12162.96 
55 3  3  2958.12  8155.08  2721.60  86336.28 
55 4  4  2579.04  8786.88  3900.96  26545.32 
 
S4_stratify 
This script will produce a stratified report for classes in a stratification map. To use this script, load maps of one type into a new view 
and order them by run year. Then add the stratification map to the view.  Next, run the script on the view and choose the stratification 
map from the list.  
 
Sample Report 
 
Year Strata_Name Strata_Value -1 - -0.999 -0.999 - 0.75 0.75 - 1 
0 0  0  70826.40 0.00  0.00 
0 1  1  0.00  51700.68 4082.40 
0 2  2  59684.04 0.00  0.00 
0 3  3  103987.80 0.00  0.00 
5 0  0  70826.40 0.00  0.00 
5 1  1  0.00  49656.24 6126.84 
5 2  2  59684.04 0.00  0.00 
5 3  3  103987.80 0.00  0.00 
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S4_stratify patch stats 
This script will produce a stratified patch size distribution report for classes in a stratification map. To use this script, load maps of one 
type into a new view and order them by run year. Then add the stratification map to the view. Next, run the script on the view and 
choose the stratification map from the list. Next, you will be prompted to enter a patch size distribution.  Enter the patch size classes 
separated by a comma and make sure the last class is larger than the largest expected patch. Ie. 100,500,999999.  
 
Sample Report 
 
Year Seral_Name Seral_Value Strata_Name Strata_Value S100 S500 S999999 
0 -1  -1  0  0  17817 8823 44187 
0 -1  -1  1  1  0 0 0 
0 -1  -1  2  2  0 0 0 
0 -1  -1  3  3  0 0 0 
0 1  1  0  0  0 0 0 
0 1  1  1  1  2563 1004 518 
0 1  1  2  2  3165 1533 3878 
0 1  1  3  3  4167 3580 2725 
0 2  2  0  0  0 0 0 
0 2  2  1  1  4954 5508 10044 
0 2  2  2  2  4218 3198 14548 
0 2  2  3  3  9701 7400 24562 
0 3  3  0  0  0 0 0 
0 3  3  1  1  4928 5336 13893 
0 3  3  2  2  5978 4837 15818 
0 3  3  3  3  10339 10990 19971 
0 4  4  0  0  0 0 0 
0 4  4  1  1  4426 2608 0 
0 4  4  2  2  1047 1464 0 
0 4  4  3  3  3697 3914 2942 
55 -1  -1  0  0  17817 8823 44187 
55 -1  -1  1  1  0 0 0 
55 -1  -1  2  2  0 0 0 
55 -1  -1  3  3  0 0 0 
55 1  1  0  0  0 0 0 
55 1  1  1  1  9189 408 0 
55 1  1  2  2  8320 188 0 
55 1  1  3  3  14473 7024 5239 
55 2  2  0  0  0 0 0 
55 2  2  1  1  9338 1558 525 
55 2  2  2  2  3891 1529 3836 
55 2  2  3  3  5320 3904 2728 
55 3  3  0  0  0 0 0 
55 3  3  1  1  4659 2469 1669 
55 3  3  2  2  3606 2161 32546 
55 3  3  3  3  9150 7151 36761 
55 4  4  0  0  0 0 0 
55 4  4  1  1  4649 5472 15847 
55 4  4  2  2  1348 1753 505 
55 4  4  3  3  6545 5126 567 
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Examples 
 
The following examples are based on the sample database that was copied into the SIMFOR install directory during the installation 
process. The database and map files are saved in a folder called Example, located within the install directory. 
 
Example I 
This example entails running a landscape level analysis using the sample database.   The analysis involves simulating the effects of a 
harvest scenario on patch size distribution for 5 seral classes.  The simulation is conducted at 10-year intervals for 5 time periods (10, 
20, 30, 40 and 50 years). 
 
1) Start SIMFOR and use Open from the File menu to select the sample .mdb database from [INSTALLDIR]\Example\. 
2) To perform the patch run, first open the Run Parameters form by clicking the Run Parameters button on the main toolbar.  You 

will see three tabs: choose the Landscape tab. 
3) Under the Landscape Run Parameters section, there will be a Landscape Statistic Type and a Class column.  The Landscape 

Statistic Type column contains the landscape analyses that SIMFOR can perform and the Class column contains the type of 
calculation.  For more information on landscape analysis types and calculation classes, see Landscape in the Run Parameters 
section. 

4) From the Landscape Statistic Type combo-box, select Patch Sizes.  The ‘ALL’ class is the default selection and will include 
patches for all seral stages in the output patch map.  Patch maps can be created for individual seral stages by selecting a specific 
seral stage in the Class column drop-down.  For more information on defining seral stages, see the section in Landscape. 

5) In the Run Years column, enter the run years to be used in the simulation.  The periods 10, 20, 30, 40, 50 should each be entered 
on a separate line.  These are the time periods for which output maps will be created. 

6) Press Run to bring up the Run Options form.  The Run options form is used to define the options for setting up the run.   
7) For this example, choose –1 for User Defined NoData.  For more information on how the User Defined NoData value is used, 

see the User Defined NoData section. 
8) To define the base map directory, first press either the Setup button on the toolbar or the Setup icon located to the right of the 

‘Base maps:’ caption.  On the Setup form, use the directory picker (directory tree icon) to choose the directory 
[INSTALLDIR]\Example\basemaps for the Base Maps Directory.  Ignore the Attribute Maps Directory, as attribute maps are 
not used in the patch analysis.  Once the directory is set, the ‘Base maps:’ caption on the Run Options form should read ‘Base 
maps: [INSTALLDIR]\Example\basemaps’.  For more information on setting map directories, see Map Directories in the Setup 
section. 

9) To select the base maps, use the Open Folder icon on the Run Options form to access the map picker for each of the 5 base maps 
- AGE, STAND, DISTURBANCE, BLOCK, CALC.  Note that maps cannot be chosen outside of the base maps directory defined 
in the previous step. 

10) To select the schedule file, use the Open File icon on the Run Options form to choose the file named ‘Penfold_Schedule.out’ 
from the directory [INSTALLDIR]\Example\.  The schedule file was produced in Atlas – a forest-level harvest simulation model.  
For more information on schedule files used by SIMFOR, see the Run Options section. 

11) To define the run directory, first use the directory picker (directory tree icon) to select [INSTALLDIR]\Example\.  Manually enter 
‘patch’ after [INSTALLDIR]\Example\ to give the run a specific name.  If the [INSTALLDIR]\Example\patch directory does not 
exist, it will be automatically created; if it already exists, it will be overwritten.  For more information on run directories, see the 
Run Options section. 

12) To execute the run, press Start.  Status messages will appear during the run to indicate progress.  
13) The run output maps can be viewed with the Data Viewer, located on the main toolbar.  Run results are accessed via the Data 

Tree under Runs->SNB->[run directory]->outmaps.  There will be 5 maps listed under the Outmaps node – each map represents 
a patch map for a separate time period. 

14) To select the 5 maps simultaneously, click on the first map (sp010), then hold down the Shift key and click on the last map 
(sp050).  With all the maps highlighted, drag and drop the selection into the Map Queue. 

15) To activate the SIMFOR legend for patch sizes, click on the legend checkbox to the left of each map within the Map Queue.  The 
seral patch legend has already been defined for the sample database and is used to display the size distribution of patches based on 
patch area.  To view the legend, open the Legend Editor and look under the Output tab for the SERAL_PATCH legend.  For 
more information on linking legends to maps, see the Legend Editor section. 

16) Select the Single option on the lower right pane of the Data Viewer, located below the Map Queue.  Manually enter a view name, 
such as PATCH, in the textbox. 

17) Press the ArcView logo to start ArcView.  The maps will be loaded into a view named PATCH and will display the SIMFOR 
patch legend. 
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18) Start the View Stepper to view the maps in a controllable sequence.  The View Stepper may be started either from the Tools 
menu or by pressing the View Stepper button, located in the lower right corner the Data Viewer.   

19) Use the Get Views button to get a list of available views from ArcView.  The ‘PATCH’ view (named in step 16) should be 
visible.  Click on the checkbox to the left of the view to load ‘PATCH’ into the View Stepper.  Note that the number of rows (R) 
and columns (C) reflect the number of views that have been loaded.  In this example, only 1 view was selected and therefore, only 
1 row and 1 column is used. 

20) Use the Scroll Up/Down buttons in the View Stepper to step through the series of patch maps.  To jump to a specific year, select 
it from the Time Period Combo-Box. For more information, see the View Stepper section. 
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 Example II 
This example entails running a habitat suitability analysis using the sample database.  The analysis simulates the effects of a harvest 
scenario on habitat suitability for a shrub-nesting songbird species.  The simulation is conducted at 10-year intervals for 5 time periods 
(10, 20, 30, 40 and 50 years). 
 
1) Start SIMFOR and use Open from the File menu to select the sample .mdb database from [INSTALLDIR]\Example\. 
2) To perform the habitat suitability run, first open the Run Parameters form by clicking on the Run Parameters button on the main 

toolbar.  You will see three tabs: choose the Habitat tab. 
3) Under the Habitat Run Parameters section, there will be a Habitat Statistic Type and a Species column.  The Habitat Statistic 

Type column contains the habitat analyses that SIMFOR can perform and the Species column contains the species on which the 
analyses are performed.  For more information on habitat analysis types, see Habitat in the Run Parameters section. 

4) From the Habitat Statistic Type combo-box, select Habitat Suitability.  From the Species combo-box, select the Shrub Nester 
species.  For more information on defining species, see the Species section. 

5) In the Run Years column, enter run years to be used in the simulation.  The periods 10, 20, 30, 40, 50 should each be entered on a 
separate line. These are the time periods for which output maps will be created. 

6) Press Run to bring up the Run Options form.  The Run options form is used to define the options for setting up the run.   
7) For this example, choose –1 for User Defined NoData.  For more information on how the User Defined NoData value is used, 

see the User Defined NoData section. 
8) To define the base and attribute maps directories, first press either the Setup button on the toolbar or the Setup icon located to the 

right of the ‘Base maps:’ caption. On the Setup form, use the directory picker (directory tree icon) to choose the directory 
[INSTALLDIR]\Example\basemaps for the Base Maps Directory. Likewise, use the directory picker to choose the directory 
[INSTALLDIR]\Example\attribmaps for the Attibute Maps Directory.  Once the base maps directory is set, the ‘Base maps:’ 
caption on the Run Options form should read ‘Base maps: [INSTALLDIR]\Example\basemaps’.  For more information on setting 
map directories, see Map Directories in the Setup section. 

9) To select the base maps, use the Open Folder icon on the Run Options form to access the map picker for each of the 5 base maps 
- AGE, STAND, DISTURBANCE, BLOCK, CALC.  Note that maps cannot be chosen outside of the base maps directory defined 
in the previous step. 

10) To select the schedule file, use the Open File icon on the Run Options form to choose the file named ‘Penfold_Schedule.out’ 
from the directory [INSTALLDIR]\Example\.  The schedule file was produced in Atlas – a forest-level harvest simulation model.  
For more information on schedule files used by SIMFOR, see the Run Options section.   

11) To define the run directory, first use the directory picker (directory tree icon) to select [INSTALLDIR]\Example\.  Manually enter 
‘shrub_nester’ after [INSTALLDIR]\Example\ to give the run a specific name.  If the [INSTALLDIR]\Example\shrub_nester 
directory does not exist, it will be automatically created; if it already exists, it will be overwritten.  For more information on run 
directories, see the Run Options section. 

12) To execute the run, press Start. Status messages will appear during the run to indicate progress.  
13) The run output maps can be viewed with the Data Viewer, located on the main toolbar.  Run results are access via the Data Tree 

under Runs->SNB->[run directory]->outmaps.  There will be 5 maps listed under the Outmaps node – each map represents a 
patch map for a separate time period. 

14) To select the 5 maps simultaneously, click on the first map (hs501_010), then hold down the Shift key and click on the last map 
(hs501_050).  With all the maps highlighted, drag and drop the selection into the Map Queue. 

15) To activate the SIMFOR legend for habitat suitability, click on the legend checkbox to the left of each map within the Map 
Queue.  The Shrub Nester habitat suitability legend has already been defined in the sample database and is used to display 3 
classes that represent high, medium and low habitat suitability.  To view the legend, open the Legend Editor and look under the 
Output tab for the SNB legend. For more information on linking legends to maps, see the Legend Editor section. 

16) Select the Single option on the lower right pane of the Data Viewer, located below the Map Queue.  Manually enter a view name, 
such as SHRUB NESTER, in the textbox. 

17) Press the ArcView logo to start ArcView.  The maps will be loaded into a view named SHRUB NESTER and will display the 
SIMFOR habitat suitability legend. 

18) Start the View Stepper to view the maps in a controllable sequence. The View Stepper may be started either from the Tools menu 
or by pressing the View Stepper button, located in the lower right corner the Data Viewer. 

19) Use the Get Views button to get a list of available views from ArcView.  The ‘SHRUB NESTER’ view (named in step 16) should 
be visible. Click on the checkbox to the left of the view to load ‘SHRUB NESTER’ into the View Stepper.  Note that the number 
of rows (R) and columns (C) reflect the number of views that have been loaded.  In this example, only 1 view was selected and 
therefore, only 1 row and 1 column is used. 

20) Use the Scroll Up/Down buttons in the View Stepper to step through the series of habitat suitability maps. To jump to a specific 
year, select it from the Time Period Combo-Box.   For more information, see the View Stepper section.  
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